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Conference posters production using PowerPoint

Poster design

Australian

S National

Summary

Paper sizes and ANU requirements
Elements of your poster

Content requirements

Design principles and recommendations
PP Tools

Printing

House and time keeping

Poster templates

ANU Marketing does not provide open access
templates for posters. It is recommended to
design the poster and approach ANU
Marketing for approval and a logo.

Link: For more information and for logo
gl.anu.edu.au/7yy0

a
University

Size
Check conference specifications for required size
Standard size - 90cm x 120cm: Paper sizes

Portrait or landscape

Print at ANU Printing Service gl.anu.edu.au/i201
printing@anu.edu.au

Poster format

If the poster is for a specific conference or
meeting it is important to follow the
requirements of the conference organizers.
Design your poster according to the space
allocated, but you do not necessarily need to
use all space. For example if you have a
portrait poster board, do not try to use the
whole space if it will make it difficult for the
audience to read from a normal standing
position.

Link: ANU Printing Service gl.anu.edu.au/i201
printing@anu.edu.au

Paper sizes

Whole Sheet
A0 A7

o
<| A6

Ad
A5

A3

A1l

‘A’ series paper sizes
as defined by the ISO 216 standard

AO0: 1189 x 841 mm (1 m?)
Al: 841 x 594 mm (%2 m?)
A2: 594 x 420 mm (%2 m?)
A3: 420 x 297 mm (etc.)
A4: 297 x 210 mm

A5: 210 x 148 mm

A6: 148 x 105 mm

To change page size in PowerPoint:
Design tab > Customize group > Slide Size
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Landscape format

.\ "Poster Sizes of bottom margin
example

LIl A3: 420 x 35.0 mm

~ el

A2: 594 x 37.5 mm

Al: 841 x 40.0 mm

= - AO: 1189 x 45.0 mm

Rogiraan Portrait format

af
= University

Size of bottom margin ep)??s{tﬁ;;{e Sizes of bottom margin
i< 3 A3: 297 x 35.0 mm

A2: 420 x 37.5 mm

Al: 594 x 40.0 mm

' AO: 841 x 45.0 mm

[, fiselen ANU requirements

Poster may need to be approved by the

ANU Requirements Marketing Office

Margin at bottom of the poster (see above) For 90x120 poster:

Font
a clear font is Arial _ . _
no requirement fo use it _(90cm = 35.433 inches. 120(,:’m = 4,&7.244
ensure the typeface you use is readable inches. Therefore approx 36” x 48")

ANU logo within margin . .
exact positioning required Black or white band at bottom = 65mm hlgh
Logo must be requested

Submit the accepted conference poster Link: Submit the accepted conference poster
gpuniescarch.anu.odu.au openresearch.anu.edu.au
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Australian
) Ba@lonal

niversity

Usage of the ANU logo

Logo only provided if the poster is
to be presented outside the ANU
at a conference or similar event

Supervisor must endorse logo use via email

Following details are required
where the presentation will be held
size of the poster i.e. A0, A1, A2, A3
portrait or landscape

For more information and for logo:
gl.anu.edu.au/7yy0

Logo
Width: 60mm

From top of band: 15mm
From right edge: 40mm

Different settings for smaller posters

Link: For more information and for logo
gl.anu.edu.au/7yy0

Elements - some

Title
Author list
often a research group

Address
Dept name
School
College
The Australian National University, Canberra ACT

Primary author email address
ORCID QR code gl.anu.edu.au/sk11

Incorporate Creative Commons licence creativecommons.ora.au

Explanation of research and images
References

A poster should

Have a Clear Purpose

Be Readily Understood

Have a Simple Format

Be Unified

Concentrate on the Graphics not the Words

Links: ORCID QR code gl.anu.edu.au/ski1l
Creative Commons licence
creativecommons.org.au

Content

Content order visually clear

Sections might include
Introduction
Aim / Background
Methods and Results
Summary (Conclusion)

Prepare text and images before placing in poster
can be edited once placed

Preparing a scientific poster

The presentation of the science is generally in
the same format as other forms of scientific
writing (i.e. Introduction, Methods,
Results/Analysis, Discussion and Conclusion).
However, the focus is on the results: The
Introduction, Discussion and Conclusion
should be brief and concise. Often the Results
and Discussion are combined.

Tell a story but minimize the narrative. If you
try to keep your word count to less than 800
words, your audience is more likely to read it.
Each text block should be <50 words.
Remember, you can have serious competition
for a reader’s time and attention.
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Planning and layout

The flow of your poster should be clear to the reader.

Use headings to convey major points.

supplementary points lower).

Introduction should be in top left, conclusions bottom right.

In general columns are easier to follow than rows.

You can use numbers or letters to label different sections/blocks in your poster.
Most important messages should appear at the top of the poster (details and

Details detract from the main point and should be avoided.

e Balance the use of graphics and text (horizontal, vertical or diagonal symmetry in

placement of figures and text).

Australian

National
niversity

Design 1

Correct information is the most important requirement
but design helps to get the message across

Columns — are usually measured in even amounts
2 or 3 or 4 equal widths
Space (gutters) between columns

If uneven widths are required
try to create a balance
+ 2 columns of equal width and 1 wider column
» example: col 1 =24 cm, col 2 =24 cm, col 3 =35cm
« allow for gutters between columns and margins

Maths
3 column layout
Allow minimum 1 cm between columnss and

for outside edge. That's a total of 4 cm for 3
columns

90 - 4
86/ 3

86 cm
28.7 cm per column

Australian
I\

Design 2

Images
size within an image program before placing

Font size
title
« 50 — 80 points (72 points = 2.54 cms or 1 old inch)
headings
« 24 -30 points
text
« 20 to 24 points

Lining up
secret of the design is to
- make sure that elements are lined up with each other
- not placed randomly

12

Figures and graphics

e Should be between 150 and 300 dpi (final
resolution)

e Each figure should illustrate one or two
points at most

e Make sure all graphics are embedded
rather than linked

e Physical area on graph should be
proportional to numbers represented

e Use same scaling if two graphs display
similar types of data

e Data should not be displayed out of
context

e Explanatory material and labels should be
included on the graph.

Digital literacy training
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Font size
Titles: At least 72 point; Headings: At least 48 point; Text: At least 24 point
Headings

e Summarises the point outlined in the subsequent text block or graphic.
e The more important the point the larger the font size.
e Make the statements as strong as the research allows.

Text

Use active voice.

Use phrases rather than full sentences.

Lists (bullet points, numbered) are useful.

Avoid jargon and acronyms.

Use a serif font (Sans-serif is alright for headings).

Left-justified text is best (fully-justified is difficult to manage in columns).
Restrict the number of fonts to 2-3 at most.

Sizing of figures and graphics in PowerPoint

Optimal pixel density of images in PP is 220 pixels per inch (ppi). Images with greater pixel
density can dramatically increase file size, while images with lower pixel density will reproduce
with inferior quality.

To find the optimal dimensions of an image in PowerPoint follow the following steps:

1. Right mouse click on the JPEG (or other file type) of the image you want to use and find
the dimensions of it in Properties, e.g. 1919 x 1079 pixels

2. Calculate the optimal dimensions of that image in inches/cm as follows:
width = 1919/220 = 8.72 inches = 22.15 cm
height = 1079/220 = 4.90 inches = 12.45 cm

Reducing the physical size of that image on your PP poster will not reduce its overall file size.
Increasing the physical size of that image on your PP poster will result in inferior image
quality.

pustatan Backgrounds and ANU colours

% National
Iniversity

e PowerPoint doesn't provide CMYK [cyan,
Design 3 magenta, yellow, and key (black)] colours,
which are usually used for print

Backgrounds . . y e Specific colours will have to set in RGB
don’t let backgrounds interfere with readability [red green and que]
ANU Colours !

ANU College of Medicine, Biology & Environment — Turquoise

« Turquoise for monitor display — R0 G124 B146 Example for BaCkgrOUnd: rlght mouse C“Ck >

Format Background > Fill > Color > More

* ANU Deep Gold — R108 G77 B35
Colours > Custom

* Charcoal — R51 G51 B51

* Platinum — R172 G192 B198

Digital literacy training 5
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Graphic design tips
For readability:

e Use black or dark-coloured text on a white or pastel background.
e Keep a reasonable amount of white-space

(>35%)
e Stick to a theme of 2 -3 colours

Consider colour differentiation (red/green colour blindness).

Austraian Ruler: View > Ruler

National

University

Tools to Help Grids: View > Gridlines

The following assists with layout Guides: View > Guides

calculator to work out measurements
PowerPoint ruler
grids
guides
snap to other objects
tip: draw boxes
* size accurately
« ‘align’ to assist in measuring up the page
+ position the guides against them
+ delete when page is structured

Australian

National
University

Tools 1

Guides (toggle Alt+F9 to show or hide)
set in the vertical and horizontal centres
+ drag to move

« drag off slide to remove

Ruler
zero point set in vertical and horizontal centres
+ not moveable

Grid (toggle Shift+F9 to show or hide)

right click background for menu option > Grid and Guides
« choose display and snap options
« alt key overrides snap options

Snap to objects
useful for lining up objects

15

pusiran PowerPoint templates

National
University

Many templates exist that can assist in
Tools 2 designing posters for PowerPoint, e.g.
Align settings A , Poster PowerPoint Templates by
Select objects > Drawing tools > Format > Align .
- align objects PosterPresentations.com (qgl.anu.edu.au/rg0t)

« distribute objects evenly

PowerPoint Research Poster Templates by
Genigraphics (qgl.anu.edu.au/22g8)

Background
Design tab > Background styles > Format background
Choose solid or gradient or insert a picture
+ can use Transparency with a picture

Digital literacy training
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University

Approximate printing costs

ANU Printer
Format must be PDF
Unlaminated $66.00
Laminated $90.00
Cloth $85.00

Australian
National

University

Backups

Backup regularly

file name with a running version number

+ poster_conf_1.pptx, poster_conf_2.pptx, poster_conf_3.pptx

Australian
National

University

Time Keeping

Posters are time consuming to get right
text
layout
not to mention printing

+ at least 2 days notice to print
* better to give preliminary booking of 1 or 2 weeks

Give yourself time!

Digital literacy training
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Summary

Prepare text

Prepare images

Build poster structure
Add text and graphics
Book the Printer

Print

20
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Other suitable software

Information on suitable types of software can be found at:

QuarkXPress Adobe Illustrator Adobe InDesign
quark.com adobe.com/products/illustrator adobe.com/products/indesign

The list above shows useful programs for designing large format posters, but there are many
others.

Resources

Examples of Posters can be found at:

PhD Posters.com (phdposters.com/gallery.php)

ePosters (eposters.net)

Creating Effective Poster Presentations (Hess, Tosney & Liegel) (gl.anu.edu.au/uaqz)

Poster Samples — The University of Texas at Austin (gl.anu.edu.au/wdin)

Poster Samples from the School of Social Science - The University of Queensland
(gl.anu.edu.au/esuy)

Poster Tips for Humanities Conference Papers — NYU Public History Program
(gl.anu.edu.au/ymmb)

PlexinB2 is required for antigen-specific
Janine J Vickers, Yi Zhang, Sharon L H Ong, Kate McKenzie, Judith A Whitworth. 2 germinal centre Iongevity
Thalk Robert J Rigby, Bhavani Balakishnan, Di Yu & Carola G Vinuesa

Dept. of Inmunology & Genetics, The John Curtin School of Medical Research,
The Australian National University, Canberra, Australia

Introduction

Methods

Samples of Conference Posters

Digital literacy training 9
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Other resources

Training notes

To access training notes, visit the Research & learn webpage anulib.anu.edu.au/research-learn
and select the skill area followed by the relevant course. You can register for a workshop and
find other information.

Research & learn how-to guides

Explore and learn with the ANU Library’s how to guides (anulib.anu.edu.au/howto). Topics
covered are:

e Citations & abstracts e Finding theses
e E-books e Increasing your research impact
e EndNote e ORCID iD (Open Researcher and

Contributor ID)
e Research Data Management

e Evaluating Sources
e Finding books and more
e Finding journal articles and more * Text and Data Mining
e Topic analysis
Subject guides

Find subject-specific guides (anulib.anu.edu.au/subjectguides) and resources on broad range
of disciplines. Such as:

e Asia Pacific, Southeast Asia and East e History, indigenous studies, linguistics
Asian studies and philosophy

e Business, economics, art, music and e Biological, environment, physical &
military studies mathematical sciences, engineering &

e Criminal, human rights and taxation computer science, health & medicine
law

Navigating the sea of scholarly communication

An open access course designed to build the capabilities researchers need to navigate the
scholarly communications and publishing world. Topics covered include finding a best-fit
publisher, predatory publishing, data citations, bibliometrics, open access, and online research
identity. Five self-paced modules, delivered by international and local experts/librarians
(anulib.anu.edu.au/publishing).

Online learning

Online learning is available through ANU Pulse, which can be accessed from both on and off
campus by all ANU staff and students (gl.anu.edu.au/pulse).

Modules available in ANU Pulse

e Microsoft Office (Access, Excel, OneNote, Outlook, PowerPoint, Project, Visio, Word)
e Microsoft Office (Mac)

e Adobe suite (Illustrator, Photoshop)

o TypelT

Training

A range of workshops are offered to help with your academic research and studies
(anulib.anu.edu.au/training-register).

Feedback

Please provide feedback about webinars on the online feedback form
(gl.anu.edu.au/libwebinar).
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